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REGULATION INFORMATIONREGULATION INFORMATIONREGULATION INFORMATIONREGULATION INFORMATION    The StenoCast X7 must be installed and used in strict accordance with the manufacturer’s instructions.  This device complies with the following radio frequency and safety standards. This device complies with Part 15 of the FCC Rules.  Operation is subject to the following two conditions: (1) This device may not cause harmful interference. (2) This device must accept any interference received, including interference that may cause undesired operation.     Federal Communication Commission Interference StatementFederal Communication Commission Interference StatementFederal Communication Commission Interference StatementFederal Communication Commission Interference Statement    This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interfer-ence to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: 
• Reorient or relocate the antenna. 
• Increase the separation between the equipment and the receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
• Consult the dealer or an experienced radio/TV technician for help.  Installation and use of this Wireless LAN device must be in strict accordance with the instructions included in the user documentation provided with the product. Any changes or modifications (including the antennas) made to this device that are not expressly approved by the manufacturer may void the user’s authority to operate the equipment. The manufacturer is not responsible for any radio or television interference caused by unauthorized modification of this device, or the substitution of the connecting cables and equipment other than manufacturer specified. It is the responsibility of the user to correct any interference caused by such unauthorized modification, substitution or attachment. Manufacturer and its authorized resellers or distributors will assume no liability for any damage or violation of government regulations arising from failing to comply with these guidelines. 
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FCC Radiation Exposure StatementFCC Radiation Exposure StatementFCC Radiation Exposure StatementFCC Radiation Exposure Statement：This equipment complies with FCC radiation exposure limits set forth for an uncontrolled environment. This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.  Your device contains a low power transmitter. When device is transmitted it sends out Radio Frequency (RF) signal. In order to maintain compliance with the FCC RF exposure guidelines, this equipment should be installed and operated with minimum distance 20cm between the radiator and your body. Use only with supplied antenna. Unauthorized antenna, modification, or attachments could damage the transmitter and may violate FCC regulations. 
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Make sure the Power schemes is set to “Always 
On,” and the Settings for Always On power 
schemes are all set to “Never.” 
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Thank you 
 Thank you for purchasing the StenoCast X7 Wireless Realtime System 

featuring Bluetooth wireless technology.  The StenoCast X7 creates a wireless          

connection between the Court Reporter’s laptop and up to seven attorney/client laptops.   

 

FEATURES 

 

• Support for Microsoft Windows 98, Windows 2000, XP Home, Windows XP Pro, 

Vista 

• Easy operation and setup 

• Sends a Wireless Realtime Signal to up to seven clients 

 

SYSTEM REQUIREMENTS 

 

• One available built-in Serial Port or one available USB port.   
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In Control Panel double click the Power Options icon. 
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Power Management: Laptop 

� Turn off power saving features 
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StenoCast X7 Quick Setup 

Guide 

                                        Step 1: 
Check the contents of your StenoCast X7 System.  There should 
be: 
• 1 StenoCast X7 Unit 
• 1 USB cable 
• 1 StenoCast X7 tote bag 
• 1 StenoCast Driver CD (with manuals) 
• 1 StenoCast X7 Instruction Manual and Quick Setup guide 
• 1 AC power supply  (not needed if you plug in via USB)  
• 1 Serial cable (not needed if you plug in via USB) 
• 1 or more USB or serial Ez Receivers 

 
                                                   Step 2: 
  
1)   Insert the StenoCast CD into your computer.   
                                                   
2)   Plug one end of the USB cable into the X7 and the other end into your 
computer.  A New Hardware Wizard window will open.    
 
 
 
 
 
3)   At the next window select Install from a list or specific location 
(Advanced) and click Next.   
 
4)   At the next window check the box that says, “Search removable media 
(floppy, CD-ROM…)” and click Next. 
 
5)   At the Completing the Found New Hardware Wizard window click          
Finish to complete the first component of the installation.  
 
6) The New Hardware Wizard will immediately reopen.  Repeat the instructions in 

steps 3 through 5 to install the remaining component, and then click Finish.        
 
Proceed to page 7. 
 
 

Note:  If a New Hardware Wizard window opens, asking if you would like 

to search the internet to locate the driver, select, “No, not at this time,” and 

click Next. 



 

6 

                                                 Step 3: 
 
If the New Hardware Found wizard does not open and a window 
opens that indicates that new hardware was found and is ready to 
use, please proceed to page 7 to locate the COM port selected for 
the X7 device. 
 
If your (court reporter) computer has a serial port and you would 
prefer to connect the X7 via that serial port, then proceed to      
connect one end of the serial cable into your computer’s serial 
port and the other end of the serial cable into the X7 unit.  You 
will then need to plug in the AC power adapter which was       
provided to power the X7 unit. 
 
Whether connected via your USB port or via the serial port, your 
StenoCast X7 is now properly connected to your computer.        
Proceed to the next section for instruction on checking the Com 
Port number assigned to your X7. 
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Make sure there is not a check mark in the box next to “Allow 
the computer to turn off this device to save power.”  After you 
click “OK,” then proceed to the next “USB Root Hub” and double 
click that item and repeat these same steps. 
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Go to Device Manager.  Scroll down to Universal Serial Bus        
controllers.  Click on the plus (+) sign.  Starting at the bottom,    
double click on USB Root Hub. 
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Step 1: 

 
Turn on your laptop or computer if 
you have not already done so.  Now 
we will check the COM port number 
of your StenoCast X7.  From your 
Windows desktop click  
 

START>CONTROL PANEL  

 
Step 3: 
 
                (Windows XP) 
 
Next, double-click the SYSTEM Icon.  
Then Click the HARDWARE tab.  
Now click the DEVICE  MANAGER 
button.   

Step 2: 
 
Check to make sure you are in     
Classic View.  If you are not, switch to 
Classic View.   
 
              (Windows XP)   
At the Control Panel window       
double-click the SYSTEM Icon.   
 
             (Windows Vista) 
At the Control Panel window       
double-click the Hardware tab. 

Checking Com Port Settings 
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Step 4: 

 

Once the Device Manager window is 
visible,  you should see a section 
labeled PORTS.  Click on the + 
sign to expand the tree.  Locate 
what COM port the StenoCast X7 
has been assigned to.  Once you 
know the COM port number the X7 
is assigned to, you are then ready 
for the last part of the Reporter 
computer setup.   
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Power Management: USB 

� Turn off USB power saving mode
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How to View Device Manager when you are “Locked 
Out” 

Click on the Start button, and then click 
Help and Support. 

In the upper left corner you should see a 
Search box.  Type in “Device Manager” and 
click the arrow. 

When the search results are displayed, in the 
left column under the heading Overviews, Arti-
cles and Tutorials, at the bottom you will see 
“Device Manager.”  Click on “Device Manager.” 

When the results are displayed in the main 
pane, you can then click on “Open Device Man-
ager.” 
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CaseCat Configuration 

Step 1:  

 

From the Default 
screen Click the 
Translate button or 
type Ctrl+T to enter 
the translate window.  
In this window make 
sure the Output To 
pull-down menu is set 
to CaseView and the 
Remember Setting 
box is Checked.  Next, 
Click the Options tab 
in the lower left corner 
of the translate        
window.   

Step 2: 

 
Then Click  the Output to 
CaseView tab.  In this    
window make sure your 
COM Port number 
matches the COM port 
assigned to your     
StenoCast X7.   Also,  
make sure that the Output 
over comm port box is 
checked and the Direct 
(Cable) bubble is selected.  
That’s it. Your CaseCat   
software is now configured 
to use the StenoCast X7.  To 
set up an attorney or client 
computer to receive realtime 
from the StenoCast X7, 
please see the X7 Client 
Manual. 
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Total Eclipse Configuration 
Step 1: 
 
From the default screen 
Click the Settings button in 
the upper left area of the 
screen.   

Step 2: 

 
Click the Realtime tab 
near the top of the window.  
You should see the current 
output format in this     
window.  Now Click the 
Change button under 
Output formats.  This will 
open the Output format 
window. 

Step 3:  

 
Now use the pull-down menu next 
to Output format and select  
Summation/CaseView.  Next, 
Click the Setup button.  This will 
open the COM Port Setup   
window.  Make sure the proper 
output COM Port is selected and 
the baud rate is set at 2400.   
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At the bottom of this window you will see COM 
Port Number and a drop-down menu with a COM 
port listed.   Select a COM number (lower numbers 
are better) and then click OK.  You may then     
receive a warning message.  Click Yes that you 
would like to continue. 
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How to Change an Assigned COM Port Number 

Go to Device Manager / Ports 

Double click on the port you would like to assign 
a different COM port number to. 

Select the Port Settings tab, and then 
click Advanced 
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DigiCAT Configuration 
Step 1: 
 
From the default screen of DigiCat , 
Click the Options tab and select 
CIC from the menu.  This will open 
the CIC Setup window. 

Step 2: 

 
Once in the CIC Setup window, 
make sure that the COM port 
listed matches that of the COM-
port that your StenoCast X7 is 
assigned to in the Device     
Manager.  Then set the baud for 
2400.  That’s it for the setup.  The 
next step will show how to initiate 
realtime transmission in DigiCAT. 

Step 3: 

 
In order to send out Realtime in 
DigiCat, Realtime must be initialized.  
When starting Realtime, select the 
Tools menu from the default screen.  
Then find CIC on the pull-down 
menu and select Start Session.  
DigiCat will now send out Realtime.  
To set up an attorney or client  
computer to receive realtime from 
the StenoCast X7, please see the X7 
Client Manual. 
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StenoCAT Configuration 

Step 1: 

 

From the default screen open 
the Tools menu at the top of 
the window.  Then select 
User Preferences from the 
menu. 

Step 2: 

 

You should now see the User 
Preferences window.  First, 
click on the Realtime tab near 
the top of the window.  Make 
sure the bubble next to Serial 
Connection is selected.  Then 
make sure the proper output 
COM port is selected and the 
baud rate is set to 2400.  Next, 
check the Setting pull-down 
menu.  It should show 8-N-1.  
Then make sure the Output 
Type is set to CaseView.  
Next click OK to save the  
settings.  Your Realtime output 
settings are now configured for 
your StenoCast X7.  Proceed 
to the next step for connection  
instructions.   
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 LCD Screen Messages 

 
StenoCast X7 
Status Ready 

 
Your X7 is plugged into either the USB port or the optional AC 
power adapter, and the X7 unit is powered on.  No wireless       
connection has been established with any Ez Receivers. 
 
 
 

StenoCast X7 
Clients Online 

 
One or more Ez Receivers have connected with the X7.  Realtime is 
ready to be initiated.  If no steno strokes have been hit, Test Mode 
will be initiated. 
 
 
 

Clients Online 
Realtime Online 

 
The wireless connection is established and realtime is being      
transmitted by the X7 and received by one or more Ez Receivers. 
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Almost all reporters will connect to their X7 via their USB port.  You may 
plug the X7 directly into the computer’s USB port or use a USB hub. 
 
Instructions for Judges / Attorneys:  Before your first use, insert 
the StenoCast CD into your CD drive.     Double click the circular red 
icon that says StenoCast Driver.  Your USB Ez Receiver driver is now I 
nstalled.  Go to Device Manager and look at Ports to determine what 
COM port the Ez Receiver was assigned to.  It will be entitled, “USB Serial 
Port” followed by the COM port number.  Jot that COM port number 
down and then enter that number in your litigation-support software’s in-
coming realtime settings. 
 
Reporters:  Note:  If you see two USB Serial Port devices listed under 
Ports, simply unplug your X7, wait a few seconds, and then plug it back in.  
Watch to see which device listing under Ports disappears and then reap-
pears.  That will be your X7. 
 
Your X7 kit comes with an optional AC power adapter.  If you choose to 
plug your X7 into your serial port, you will then use the AC power 
adapter to power the X7 device.  If you plug in via your USB port, no   
outside power source is necessary. 
 

Quick Setup Guide 
 

1) Plug the USB cable into the X7 and the other end into your computer. 
2) Have the Judge/Attorneys plug in their USB Ez Receivers and open up 

a realtime file in their litigation-support software. 
3) The X7 will automatically go into Test Mode.  The X7 will transmit the 

message “Wireless Connection Successful” every ten seconds.  This 
will allow the parties to test the realtime signal without the reporter 
hitting keys on their steno machine.  Test mode will stop once the  
reporter hits their first steno stroke.  To re-initiate Test Mode, either 
unplug the USB cable or AC adapter and then plug it back in, or you 
may press the reset button on the back of the X7 device. 

Getting familiar with your 

StenoCast X7 
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Step 3: 
 

From the default screen open the 
File menu.  Then select Start 
Realtime.   

Step 4: 
 
From the Realtime window select 
Start new job (or append to ex-
isting job if you wish).  Then click 
OK. 

Step 5: 
 
Choose a name for the new job (or 
select an existing file if appending 
an existing job).  Then click OK.  
That’s it.  You are now sending out 
realtime wirelessly with your 
StenoCast X7.  To set up an      
attorney or client computer to  
receive realtime from the      
StenoCast X7, please see the X7 
Client Manual. 
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SmartCAT Configuration 

Step 1: 
 
From the default screen 
open the Setup menu at 
the top of the window.  
Then select Realtime   
Options from the menu. 

Step 2: 
 
You should now see the 
Realtime Options window.  
Select Caseview as your 
Output Format.  Then click 
the Setup button next to the 
Output Format. 

Step 3: 
 
Once in the Caseview Output Set-
tings window, make sure that 
the COM port listed matches 
the COM port that was       
assigned to the X7 in the    
Device Manager.  Proceed to 
the next step for instructions on 
how to send out realtime with 
SmartCAT. 
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Step 4: 
 
To start realtime in SmartCAT, 
open the File menu near the top 
of the window.  Then select 
New Job from the menu. 

Step 5: 
 
You will now see the New Job 
window.  Enter all appropriate 
information and then click OK. 

Step 6: 
 
Next, open the Realtime 
menu near the top of the    
window.  Then select Start 
Realtime.  You are now  
sending out Realtime wirelessly 
with your StenoCast X7.  To 
set up an attorney or client 
computer to receive realtime 
from the StenoCast X7, please 
see the X7 Client Manual. 


